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Matrox Software License Agreement

(HEREAFTER REFERRED TO AS LICENSE)

THIS IS A LEGAL AGREEMENT BETWEEN THE LICENSEE AND MATROX ELECTRONIC SYSTEMS LTD
(“MATROX”) CONCERNING THE USAGE OF THE MATROX SOFTWARE. BY DOWNLOADING,
INSTALLING, COPYING, ACCESSING, CLICKING ON AN “ACCEPT” BUTTON, OR OTHERWISE USING
THE SOFTWARE, THE LICENSEE AGREES TO THE TERMS OF THIS LICENSE. IF YOU ARE ACCEPTING
THESE TERMS ON BEHALF OF YOUR COMPANY, ORGANIZATION, EDUCATIONAL INSTITUTION, OR
AGENCY, INSTRUMENTALITY, OR DEPARTMENT OF THE FEDERAL GOVERNMENT AS ITS
AUTHORIZED LEGAL REPRESENTATIVE, YOU REPRESENT AND WARRANT THAT YOU HAVE FULL
AUTHORITY TO BIND LICENSEE TO THESE TERMS. IF YOU DO NOT AGREE TO THE TERMS OF THIS
LICENSE, PLEASE RETURN YOUR MATROX PRODUCT. IF THE SOFTWARE WAS DOWNLOADED,
DESTROY ALL COPIES OF THE SOFTWARE.

In this License “Software” refers to: any firmware, software, associated software components, media, printed
materials, and “online” or electronic documentation related to Matrox products.

The Software is not sold, and instead is only licensed for use, strictly in accordance with this document. This License
does not cover the sale of hardware, since it may not necessarily be sold as a package with the Software. This License
sets forth the terms and conditions of the Software license only.

Any Software provided to Licensee is the copyrighted work of Matrox and/or third party software suppliers (if any).
The present License does not give Licensee any intellectual property rights to the Software or its derivatives. The
downloading and/or the use of any Software are subject to the following restrictions and limitations:

LICENSES:

If you are an end user, the “End User License” shall apply to you.

If you are an original equipment manufacturer (OEM), the “OEM License” shall apply to you.

END USER LICENSE
1 Licensee may install the Software on an unlimited number of computers owned or leased by Licensee in any
location. The Software is subject to a restricted license therefore Licensee must use the Software on a single
computer owned or leased by Licensee at a time, in conjunction with and for the purpose of, operating the Matrox
hardware product. Use of the Software in conjunction with non-Matrox products is prohibited and not licensed
hereunder. Licensee shall also have the right to make one copy of the Software in any computer-readable or printed
form for back-up or archival purposes;

N

No right to recopy, publish, display, network, rent, loan, lend, assign, sell, distribute, license, sub-license, alter,
modify, disassemble, de-compile, create derivative works or reverse engineer any Software in any manner
whatsoever is hereby given, except as provided in this License. Violation may result in severe civil and/or criminal
penalties, as violators will be prosecuted to the maximum extent possible;

3 Licensee agrees to treat the Software as confidential information, and shall protect said information by using the
same degree of care Licensee uses to protect Licensee's own confidential information, but no less than a
reasonable degree of care, to prevent the unauthorized use, dissemination, disclosure or publication of such, or to
use this Software to: (i) develop inventions directly derived from confidential information to seek patent
protection; (ii) assist in the analysis of Licensee's patents and patent applications; or (iii) modify Licensee's
existing patents or patent applications;

4 Licensee may only provide and disclose parts of the Software to third parties who have a need-to-know for the
purpose of installation, service integration and/or support of said Software within Licensee's product. In such
event, Licensee may only disclose the relevant and necessary parts of the Software to permit the third party to
accomplish his work provided that all such disclosures shall be subject to the terms and conditions of this License;

5 Licensee may not grant any sublicense, lease or other right in the Software to others;
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6 Notwithstanding any other provision in this License, if Licensee provides any ideas, suggestions or
recommendations to Matrox regarding the Licensed Software and/or Licensee's product (“Feedback™),
Matrox is free to use and incorporate such Feedback in Matrox's products, without payment of royalties or
other consideration to Licensee;

7 Licensee shall not have the right to alter or remove any Matrox or third party copyright, trademark or patent
notices in the Software.

OEM LICENSE
Licensee may reproduce and distribute the Software only as an integral part of or incorporated in Licensee's
product or as a standalone Software maintenance update for existing end users of Licensee's products, excluding
any other standalone products, subject to these conditions:
1 This Software is subject to a restrictive license therefore it is licensed for use only in conjunction with the
Matrox hardware product. Use of the Software in conjunction with non-Matrox products is prohibited and not
licensed hereunder;

N

No right to recopy, publish, display, sell, network, rent, loan, lend, distribute, license, sub-license, alter,
modify, disassemble, de-compile, create derivative works or reverse engineer any Software in any manner
whatsoever is hereby given, except as provided in this License. Violation may result in severe civil and/or
criminal penalties, as violators will be prosecuted to the maximum extent possible;

3 Licensee agrees to treat the Software as confidential information, and shall protect said information by using
the same degree of care Licensee uses to protect Licensee's own confidential information, but no less than a
reasonable degree of care, to prevent the unauthorized use, dissemination, disclosure or publication of such,
or to use this Software to: (i) develop inventions directly derived from confidential information to seek
patent protection; (ii) assist in the analysis of Licensee's patents and patent applications; or (iii) modify
Licensee's existing patents or patent applications;

4 Licensee may only distribute the Software to Licensee's customers pursuant to a written license agreement.
At a minimum such license shall safeguard Matrox's ownership rights to the Software and such agreement
shall contain similar terms and obligations;

5 Licensee may only provide and disclose parts of the Software to third parties who have a need-to-know for
the purpose of installation, service integration and/or support of said Software within Licensee's product. In
such event, Licensee may only disclose the relevant and necessary parts of the Software to permit the third
party to accomplish his work provided that all such disclosures shall be subject to the terms and conditions
of this License;

6 Notwithstanding any other provision in this License, if Licensee provides any ideas, suggestions or
recommendations to Matrox regarding the Licensed Software and/or Licensee's product (“Feedback”),
Matrox is free to use and incorporate such Feedback in Matrox's products, without payment of royalties or
other consideration to Licensee.

7 Licensee shall not have the right to alter or remove any Matrox or third party copyright, trademark or patent
notices in the Software.

GENERAL LICENSE TERMS: (APPLICABLE TO BOTH END-USERS & OEM'S)

There are inherent dangers in the use of any software available for downloading on the Internet and Matrox
cautions Licensee to ensure that Licensee completely understands the potential risks before downloading any of
the Software. Licensee is solely responsible for adequate protection and backup of the data and equipment used
in connection with any of the Software, and Matrox will not be liable for any damages that may be suffered in
connection with use of the Software.

Licensee hereby acknowledges and agrees that this License, and all its terms and conditions, automatically
applies, without other notice, to future updates of the Software, firmware, BIOS, drivers and associated utilities.

In addition, certain third party intellectual property may be provided with or included in the Software. The third
party license terms accompanying such Software, found at http://www.matrox.com/video/licenses and if
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applicable, in the license.txt file located in the root installation directory, will govern your use of such Software.
Matrox does not warrant and is not liable for such third party intellectual property, or anything related thereto.
Licensee acknowledges and agrees to comply with the terms of all applicable third party software licenses if any.
Please be advised that the terms and conditions of third party license agreements may be updated from time to time. It
is the Licensee responsibility to verify that the agreement listed is current and applicable. Please note that this list of
third party licenses is not exhaustive and was determined according to Matrox's understanding and to the best of its
knowledge.

PRE-RELEASE LICENSE EXCLUSION: If you are using a version of the licensed Software that is designated,
without limitation, as an alpha, beta, engineering sample, preliminary or early access version of the Software, then; (a)
the Software is deemed to be pre-release code (e.g. alpha or beta, engineering sample, preliminary, early access, etc.),
which may not be fully functional and which Matrox may substantially modify in development of a commercial
version, and for which Matrox makes no assurances that it will ever develop or make generally available in a
commercial version, and (b) Licensee shall have the right to use the Software only for the duration of the pre-release
term or until the commercial release, if any, of the Software, whichever is shorter. For clarity, a remedy to any bug,
defect, error or fault in any pre-release version of the Software will absolutely require upgrading to a new version of
the Software. Matrox reserves the right to change any content of this new version of the Software at its sole discretion.

COPYRIGHT

All title, including but not limited to copyrights, in and to the Software and any copies thereof are owned by Matrox or
its suppliers. All title and intellectual property rights in and to the content which may be accessed through use of the
Software is the property of the respective content owner and may be protected by applicable copyright or other
intellectual property laws and treaties. This License grants you no rights to use such content. All rights not expressly
granted are reserved by Matrox.

DISCLAIMER OF WARRANTIES

LICENSEE EXPRESSLY ACKNOWLEDGES AND AGREES THAT USE OF THE SOFTWARE IS AT
LICENSEE'S SOLE RISK. THE SOFTWARE IS PROVIDED “AS IS” AND WITHOUT WARRANTY OF ANY
KIND AND MATROX EXPRESSLY DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NON-INFRINGEMENT OF ITS SOFTWARE AND ANY THIRD PARTY
INTELLECTUAL PROPERTY. MATROX DOES NOT WARRANT THAT THE CONTENTS OF THE SOFTWARE
WILL MEET LICENSEE'S REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE WILL BE
UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. THE
ENTIRE RISK ASSOCIATED WITH THE USE OF THE SOFTWARE IS ASSUMED BY LICENSEE.
FURTHERMORE, MATROX DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE
USE OR THE RESULTS OF THE USE, OF THE SOFTWARE OR ANY THIRD PARTY INTELLECTUAL
PROPERTY IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR
OTHERWISE. SHOULD THE CONTENTS OF THE SOFTWARE PROVE DEFECTIVE, LICENSEE ASSUMES
THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. SOME JURISDICTIONS
DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT
APPLY TO LICENSEE.

LICENSEE ACKNOWLEDGES AND AGREES THAT LICENSEE IS SOLELY RESPONSIBLE FOR
DETERMINING WHETHER ANY THIRD PARTY PATENT OR COPYRIGHT LICENSES, INCLUDING BUT
NOT LIMITED TO VARIOUS AUDIO AND VISUAL STANDARDS, ARE NECESSARY TO USE, IMPLEMENT
OR DISTRIBUTE THIS PRODUCT, WHICH INCLUDES ANY OR ALL SOFTWARE OR HARDWARE.
LICENSEE IS RESPONSIBLE TO ADVISE LICENSEE'S CUSTOMERS OF THE LIMITATIONS PROVIDED
HEREIN.

LIMITATION OF LIABILITY

UNDER NO CIRCUMSTANCES SHALL MATROX, ITS SISTER COMPANIES, ITS SUBSIDIARIES BE LIABLE
FOR ANY DIRECT, INDIRECT, PUNITIVE, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES
THAT RESULT FROM THE USE OF, OR INABILITY TO USE, THE SOFTWARE. THIS LIMITATION APPLIES
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WHETHER THE ALLEGED LIABILITY IS BASED ON CONTRACT, TORT, NEGLIGENCE, STRICT
LIABILITY, OR ANY OTHER BASIS, EVEN IF MATROX HAS BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE. BECAUSE SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, MATROX'S LIABILITY IN SUCH
JURISDICTIONS SHALL BE LIMITED TO THE MINIMUM REQUIRED BY LAW.

UNAUTHORIZED USE. THIS SOFTWARE RELATED THERETO ARE NOT DESIGNED, INTENDED,
AUTHORIZED OR WARRANTED TO BE SUITABLE FOR USE OR RESALE IN ANY TYPE OF SYSTEM
OR OTHER APPLICATIONS RELATED TO, HAZARDOUS OR POTENTIALLY HAZARDOUS
ENVIRONMENTS OR APPLICATIONS REQUIRING HIGH-AVAILABILITY OR FAIL-SAFE
PERFORMANCE, WHERE PERSONAL INJURY OR DEATH MAY OCCUR, SUCH AS MEDICAL
SYSTEMS, LIFE SUSTAINING, LIFE SAVING SYSTEMS, OPERATION OF NUCLEAR FACILITIES,
AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, PUBLIC
WORKS, WEAPONS SYSTEMS, OR ANY OTHER APPLICATION IN WHICH THE FAILURE OF A
PRODUCT COULD LEAD TO PROPERTY DAMAGE, ENVIRONMENTAL DAMAGE, OR PERSONAL
INJURY. LICENSEE WILL NOT USE, OR PERMIT TO BE USED, THE PRODUCTS FOR SUCH
HIGH-AVAILABILITY, FAIL-SAFE OR CRITICAL APPLICATIONS AND FURTHER, LICENSEE AGREES
TO INDEMNIFY, DEFEND AND HOLD HARMLESS MATROX AND ITS MANAGERS, DIRECTORS,
OFFICERS, EMPLOYEES, AGENTS, AFFILIATES, SUCCESSORS, ASSIGNS AND ITS 3RD PARTY
SUPPLIERS FROM AND AGAINST ANY ACTION, SUIT, PROCEEDING, COST, EXPENSE, DAMAGES,
AND LIABILITY (INCLUDING, BUT NOT LIMITED TO, REASONABLE ATTORNEYS' FEES) ARISING
OUT OF, OR RELATED TO, THE BREACH OF LICENSEE'S OBLIGATIONS RELATED HERETO, EVEN
IF SUCH CLAIM ALLEGES THAT MATROX WAS NEGLIGENT REGARDING THE DESIGN OR
MANUFACTURE OF THE SOFTWARE.

DISCLAIMER OF WARRANTIES AND LIMITATION OF LIABILITIES FOR THIRD PARTY SOFTWARE
INCLUDED WITH OR IN THE SOFTWARE. ALL THIRD PARTY SOFTWARE INCLUDED WITH THE
SOFTWARE IS PROVIDED ON AN “AS IS” BASIS. MATROX AND ITS 3RD PARTY SUPPLIERS MAKE
NO WARRANTY TO LICENSEE, WHETHER EXPRESS OR IMPLIED, INCLUDING WITHOUT
LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE AND NON-INFRINGEMENT, REGARDING ANY THIRD PARTY SOFTWARE,
OR ITS USE AND OPERATION ALONE OR IN COMBINATION WITH LICENSEE PRODUCTS.
NEITHER LICENSEE, NOR ITS EMPLOYEES, AGENTS, OR DISTRIBUTORS HAVE ANY RIGHT TO
MAKE ANY OTHER REPRESENTATION, WARRANTY OR PROMISE WITH RESPECT TO ALL THIRD
PARTY SOFTWARE INCLUDED WITH THE SOFTWARE.

MATROX HAS NO OBLIGATION TO INDEMNIFY, DEFEND OR HOLD LICENSEE HARMLESS FROM
AND AGAINST ANY CLAIM THAT ANY THIRD PARTY SOFTWARE INFRINGES ANY THIRD PARTY
PATENT, COPYRIGHT, TRADEMARK OR OTHER INTELLECTUAL PROPERTY RIGHT. LICENSEE
WILL PROMPTLY NOTIFY MATROX IN WRITING OF ANY SUCH CLAIM.

MATROX HAS NO OBLIGATION TO INDEMNIFY, DEFEND OR HOLD LICENSEE HARMLESS FROM
AND AGAINST ANY CLAIMS OF INFRINGEMENT OF INTELLECTUAL PROPERTY THAT READS
UPON OR IS INFRINGED BY A GENERALLY RECOGNIZED AUDIO, VIDEO, TECHNOLOGY OR
PATENT STANDARD OR RECOMMENDATIONS, INCLUDING WITHOUT LIMITATION AVC/H.264,
IEEE 1394, JPEG, JPEG2000 AND MPEG-4.

IN ANY EVENT, MATROX'S TOTAL CUMULATIVE LIABILITY TO LICENSEE FOR ANY AND ALL
CAUSE OF ACTION SHALL BE LIMITED TO THE AGGREGATE OF ALL AMOUNTS PAID BY
LICENSEE TO MATROX, DURING THE TWELVE (12) MONTH PERIOD PRIOR TO OBTAINING A
FINAL, NONAPPEALABLE JUDGMENT OR $50,000.00 USD, WHICHEVER IS LOWER. THE
FOREGOING LIMITATIONS WILL APPLY EVEN IF THE ABOVE STATED REMEDY FAILS OF ITS
ESSENTIAL PURPOSE.

Matrox Software License Agreement



Vi
TERMINATION
This License will automatically terminate if Licensee fails to comply with any of the terms and conditions hereof. In
such event, Licensee must destroy all copies of the Software and all of its component parts. Matrox reserves the right

to terminate this License without prejudice to any additional recourses Matrox may have against Licensee if Licensee
violates any of this Licenses' terms and conditions.

Matrox will not, by reason of the termination of this License, be liable for compensation, reimbursement or damages
on account of the loss of prospective profits on anticipated sales, or on account of expenditures, investments, leases, or
commitments in connection with the Licensee's business or goodwill or otherwise. If Licensee commences or
participates in any legal proceeding against Matrox then Matrox may, in its sole discretion, suspend or terminate all
license grants and any other rights provided under this License during the pendency of such legal proceedings.

MISCELLANEOUS

If any provision of this License is inconsistent with, or cannot be fully enforced under, the law, such provision will be
construed as limited to the extent necessary to be consistent with and fully enforceable under the law. This License is
the final, complete and exclusive agreement between the parties relating to the subject matter hereof, and supersedes
all prior or contemporaneous understandings and agreements relating to such subject matter, whether oral or written.
This License may only be modified in writing signed by an authorized officer of Matrox. Licensee agrees that it will
not ship, transfer or export the Software into any country, or use the Software in any manner, prohibited by the United
States Bureau of Industry and Security and shall fully comply with all United States relevant export laws, restrictions
or regulations and any other applicable export and import laws.

Controlling Law. The validity, performance and construction hereof shall be governed by and interpreted in
accordance with the laws of the Province of Quebec. Both parties hereby irrevocably submit to the exclusive
jurisdiction of the Courts of the district of Montreal, Province of Quebec, Canada with regard to any dispute arising out
of or in connection with this License.

Additional information may be available on the Matrox website. If used, this site may contain other proprietary notices
and copyright information, the terms of which must also be observed and followed.

The failure of Matrox to enforce at any time any of the provisions of this License, or the failure to require at any time
performance by the Licensee of any of the provisions of this License, shall in no way be construed to be a present or
future waiver of such provisions, nor in any way affect the right of Matrox to enforce each and every such provision
thereafter.

Any and all articles and/or sections which by their nature are required to survive termination of this License shall
survive.

ANY INTERPRETATION OF THE CONTENTS, RIGHTS AND OBLIGATIONS OF THE CONTENTS OF THIS
NOTICE AND/OR MATROX WEB SITE SHALL BE INTERPRETED IN ACCORDANCE WITH THE LAWS OF
QUEBEC.

All rights reserved by Matrox.

Matrox reserves the right to change Software specification without notice. All intellectual property, including without
limitation, trademarks and copyrights are the property of their respective owners and any unauthorized use thereof is
strictly prohibited.

COPYRIGHT © 2015 Matrox is a trademark of Matrox Electronic Systems Ltd.
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Introduction

This chapter lists the Monarch
HD supported input formats,
system requirements, and
describes the Monarch HD
documentation.



Welcome to Matrox Monarch HD

Matrox Monarch HD is a small, easy-to-use video streaming and recording
appliance designed for professional video producers who need to simultaneously
stream a live event and record the master quality version for post-event editing.
By separating the task of recording from streaming in a single integrated unit,
Matrox Monarch HD ensures that the Content Delivery Networks (CDNs) are
focused on delivering quality video to your audience while you control the
quality of the archive.

From any HDMI input source such as a camera or switcher, Matrox Monarch HD
generates an H.264-encoded stream compliant with RTSP or RTMP protocols.
While encoding the video at bit rates suitable for live streaming, Matrox Monarch
HD simultaneously records a high-quality MP4 or MOV file to an SD card, a
USB drive, or a network-mapped drive. Matrox Monarch HD is remotely
controlled using any computer or mobile device with a web browser.

Supported input formats

Matrox Monarch HD supports the following video input formats:

* 1920 x1080p at 23.98/24/25/29.97/30/50/59.94/60 fps
* 1280 x720p at 50/59.94/60 fps
* 1920 x1080i at 23.98/24/25/29.97 fps

Supported operating systems
The Matrox Monarch HD Ultils application is used to perform firmware updates
and acquire the device network IP address when connected to a network with a
DHCEP server. The application supports the following operating systems:
* Mac OS X El Capitan
* Microsoft Windows 10
Note Youmusthave Microsoft NET Framework installed. This release was
tested with the latest version: http://www.microsoft.com/en-ca/download/

Other operating systems may work but have not been fully validated through
internal testing. Before trying another operating system, please contact
MonarchHDSupport@matrox.com with any questions.
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Supported Web browsers

Matrox Monarch HD has been tested for use with the following Web browsers:
* Microsoft Internet Explorer
» Apple Safari

Other browsers may work but have not been fully validated through internal
testing.

Note If you experience display issues in the Command Center when using
Monarch HD with Internet Explorer (11 or higher), disable Compatibility View
and set the Document mode to Edge:

8 From Internet Explorer, go to Tools > Compatibility View Settings, clear
Display intranet sites in Compatibility View, and then click Close.
9 Press F12 to open the developer tools interface, select Edge (default) from

the document mode drop-down menu, and then press F12 to close the tools.

The Command Center should now display properly.

Streaming

Monarch HD provides streaming settings for using RTSP and RTMP streaming
protocols for use on media servers, video players and Content Delivery Networks
(CDN:).

Recording

Monarch HD provides settings for recording your input source for video on
demand (VOD), high-quality editing, and archiving/previewing purposes.

About this guide

This guide provides you with information about connecting and using your
Matrox Monarch HD device.

Style conventions
The following style conventions are used in this guide:

* The names of files, folders, and documents appear in italics. For example:
— The data is stored in the Sample.mov file.
— The file is located in the Clips folder.
— Please refer to your Matrox Monarch HD Release Notes.

* Menus and commands that you need to choose are displayed in the form
Menu > Command. For example, File > Save means click File in the
menu bar, and then click Save in the menu that appears.

Supported Web browsers
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Matrox Monarch HD Hardware and
Connections

This chapter describes the
Matrox Monarch HD
connections (video/audio,
LAN, and recording), buttons,
status LEDs, and shows how
to power and reset Monarch
HD.



Matrox Monarch HD hardware
This section explains the Matrox Monarch HD hardware components. For
hardware technical specifications, see Appendix C, “Matrox Monarch HD
Specifications.”

o & @, o;‘f._

-
usg1——! usg2 ——! SD CARD ————————————]

STRlEAM RE(iORD I |
v—V
See “Status Stream button USB port 1 SD card slot
LEDs” on
page 12. Record button USB port 2
Streaming and recording
I-iE <« B > .S
> (<=
-I = © © .
5V=—=3A LAN out N @-} 0‘9‘
- | | n
| | | | =
Power LAN HDMI out HDMI in output input Reset
button

‘ Analog audio

Video/audio inputs and outputs

Streaming and recording
This section details the Monarch HD hardware components that are used for
streaming and recording.

Stream button

The Stream button’s functionality depends on the selected stream mode (RTSP or
RTMP). The Stream button is disabled when Monarch HD is set to Record-only
operating mode. For information on specifying your stream settings, see “About
page” on page 50.
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e RTSP mode If Monarch HD is set to stream in RTSP mode, the unit
delivers stream data once a client connects to Monarch HD using the RTSP
streaming protocol, and therefore does not require you to press the Stream
button. When a client connects to Monarch HD, the Stream LED flashes.

* RTMP mode If Monarch HD is set to stream in RTMP mode, press the
Stream button to begin streaming your input source to the stream destination
specified in the stream settings. Pressing the Stream button starts the stream
for that device only. If your Monarch HD is set to control multiple Monarch
HD devices, you must use the control buttons on the Control page of the
Command Center to start and stop streaming multiple Monarch HD devices
on the network at the same time (see “Control streaming and recording for
multiple devices on the same network™ on page 28). When streaming, the
Stream LED flashes. Press the Stream button again to stop streaming.

Note The Stream button activates when you release the button. If you want
to start/stop streaming and recording at the same time, press and hold the
Stream and Record buttons and then release them at the same time.

Record button

Press the Record button to start recording your input source to the media selected
in the record settings. The Record button is disabled when Monarch HD is set to
Stream-only operating mode. For information on specifying your record settings,
see “Specifying Recording settings” on page 37. Pressing the Record button
starts the recording for that device only. If your Monarch HD is set to control
multiple Monarch HD devices, use the control buttons on the Control page of the
Command Center to start and stop recording multiple Monarch HD devices on
the network at the same time (see “Control streaming and recording for multiple
devices on the same network™ on page 28). When recording, the Record LED
flashes. Press the Record button again to stop the recording. Unless a specific
record duration limit was set in the record settings, Monarch HD limits the
duration of each recording to four hours and 50 minutes. The recording will
automatically stop when the duration limit is reached.

Note The Record button activates when you release the button. If you want to
start/stop recording and streaming at the same time, press and hold the record and
Stream buttons and then release them at the same time.

USB ports 1 and 2

Use the USB ports to connect a USB 2.0 or 3.0 media device for recording the
source connected to the Monarch HD HDMI input. To select USB port 1 or 2 as
the recording destination, see “Specifying Recording settings” on page 37.

Please note the following about using USB devices:

* Monarch HD writes to all USB devices (including USB 3.0 devices) at USB
2.0 speeds.
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* The performance of USB keys or “thumb drives” varies. Many of these
devices are optimized for “read” operations, while the Monarch HD requires
sustained “write” capabilities. For best results, especially at higher recording
data rates, powered USB drives are recommended. In some cases, SD cards
may be more suitable when small portable media is required.

* Monarch HD supports USB devices with FAT32 or NTFS file systems.
Media may need to be reformatted if not recognized by the Monarch.

* USB devices with password protection are not supported.

* It may take a few seconds for Monarch HD to detect a newly connected USB
device (verified on the status page).

* For USB 3.0 hard drives without a dedicated power supply, Monarch HD
may not be able to sufficiently power more than one USB 3.0 drive at a time.

* When a recording is stopped, it may take a few moments for Monarch HD to
finalize the file, during which the USB LED continues to flash. To avoid
corrupted video files, do not remove the USB device when its LED is
flashing.

* Connecting a USB device to USB port 2 and then performing a device reboot
allows you to save the Monarch’s current IP address and status as a text file
(see “Device reboot” on page 11).

* Connecting a USB device to USB port 2 and then performing a factory reset
allows you to load pre-configured Monarch settings (see “Automatic
configuration page” on page 45).

SD card

Use the SD card slot for recording the source connected to the Monarch HD
HDMI input to an SD card. Monarch HD supports SD and SDHC cards with
FAT32 or NTFS file systems. To ensure that your SD card is fast enough to
record at higher bit rates, we recommend using an SD card with a Class 10 speed
rating. To select the SD card slot as the recording destination, see “Specifying
Recording settings” on page 37.

Remarks
* It may take a few seconds for Monarch HD to detect a newly inserted SD
card.

* When a recording is stopped, the SD card LED continues to flash while the
Monarch HD finalizes the file. To avoid corrupted video files, do not remove
the SD card when its LED is flashing.

Video/audio inputs and outputs
Matrox Monarch HD only supports HD video signals. If you connect an input
signal with a resolution smaller than 1280x720, the Monarch HD will not detect
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the connected input, and the video output and web interface will display “No
video signal”.

HDMI in
Provides an input for HD HDMI video (YUV or RGB) from a digital HDMI
device for streaming and recording.

Important Monarch HD does not support upscaling the input source for
streaming or recording. For more information on supported HDMI input formats,
see “Supported input formats” on page 2.

Monarch HD supports the first two channels of uncompressed embedded audio
from the HDMI input source for streaming and recording. HDCP and SD sources
are not supported on this input. You can monitor the HDMI input source by
connecting an HDMI monitor to Monarch HD’s HDMI output. To select whether
to stream and record the first two audio channels present in the HDMI input or
the audio connected to the Monarch HD analog audio input, see “Audio Settings
page” on page 39.

HDMI out

Provides a preview of the HDMI input, and the audio selected as the audio input
source. You can choose between the first two audio channels present in the
HDMI input or the audio connected to the Monarch HD analog audio input (see
“Audio Settings page” on page 39). HDCP and SD signals are not supported on
this output. The HDMI output supports RGB devices. To monitor your input
source, the HDMI monitor must support the video input format.

Analog audio input

Allows you to input an unbalanced stereo analog audio source for streaming and
recording. To select whether to stream and record the first two audio channels
present in the HDMI input or the audio connected to the Monarch HD analog
audio input, see “Audio Settings page” on page 39.

Analog audio output
Provides an unbalanced stereo analog audio output for monitoring the audio
selected as the audio input source.

LAN

The LAN port is an auto-sensing 10/100/1000 Base-T Ethernet port used to
connect Monarch HD to an Ethernet network via a standard RJ-45 Ethernet
cable. For information on how to connect to a network, see Chapter 3, “Network
Connection and Setup.”

Matrox Monarch HD hardware
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Powering Monarch HD

Power the Monarch HD device using an AC outlet via the external power supply
and a power cord. When power is supplied to Monarch HD, the device begins a
power-up sequence during which all LEDs illuminate. The device is ready when
two or more of the recording destination LEDs (USB port 1, USB port 2, SD
Card) turn off, depending on your settings. To power off Monarch HD,
disconnect Monarch HD from the power source. For power specifications, see
Appendix C, “Matrox Monarch HD Specifications.”

Note When the device is powered off, all current settings are maintained and
any logged errors are cleared (see “Monarch HD errors” on page 24).

Monarch HD

—

disconnecting the power
supply from Monarch HD,
make sure that you slide
back the casing on the
connector to release the
locking mechanism.

External
power supply

Power cord

To AC
outlet

Using the Reset button
You can use the Monarch HD Reset button to reboot the device (quick button
press), or reset the device to factory defaults (long press of at least five seconds).

In addition to the typical reasons for rebooting the Monarch (fixing errors or
other issues), a reboot (see ‘“Device reboot” on page 11) also saves the Monarch’s
IP address and status to a connected USB device (USB port 2) as a text file. This
is a convenient way to find the Monarch’s IP address.

A factory reset allows you to switch to a Static IP (see“Switch to Static IP mode”
on page 11), or load pre-configured Monarch settings from a configuration file on
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a USB device connected to USB port 2 (see “Automatic configuration page” on
page 45).

Remarks
* A power cycle of the Monarch HD performs a simple reboot, not a reset to
factory defaults.

* When using the Reset button, any saved profiles for streaming and recording
are maintained, and all logged errors are cleared (see “Monarch HD errors”
on page 24).

» The Reset button is recessed in order to prevent unintended activation. Use a
straightened paper clip, or similar device, to press the Reset button.

* Holding the Reset button pressed for more than five seconds will reset the
device to factory defaults.

Device reboot
When performing a device reboot, all current settings are maintained, including
the IP mode (DHCP or Static) that was set prior to the reboot.

Note To reboot the device and switch to Static IP mode, see “Switch to Static
IP mode” on page 11.”

If you have a USB device connected to USB port 2 on the Monarch device, the
Monarch’s current IP address and status is saved to the USB device as a text file.
This is a convenient way to find the Monarch’s IP address.

To reboot Monarch HD, do one of the following:

» Using a paper clip, press the recessed pinhole Reset button on the device.
The device begins a power-up sequence during which all LEDs illuminate.
The device is ready when two or more of the recording destination LEDs
(USB port 1, USB port 2, SD Card) turn off, depending on your settings.

* Open the Matrox Monarch HD Utils application, select the Monarch HD
device you wish to reboot, and then click Reboot Selected.

Switch to Static IP mode
You can switch your Monarch HD device to Static IP mode by pressing the
Record button while the Record LED flashes during the power-up sequence.

1 Press the Reset button on the device to initiate a device reboot. During the
power-up sequence (all LEDs illuminate), the Record LED flashes for three
seconds.

2 Press the Record button on the device while the Record LED is flashing.
This sets the device to Static IP mode and the Static IP address to its default
address (169.254.1.11).

The device is ready when two or more of the recording destination LEDs (USB
port 1, USB port 2, SD Card) turn off, depending on your settings.

Matrox Monarch HD hardware
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Reset to factory defaults

When resetting Monarch HD using this method, all Monarch HD settings reset to
factory defaults, the device password resets to admin, and the device powers up
in DHCP IP mode for connecting to a network with a DHCP server, such as a
router. To switch the device to Static IP mode after performing a factory reset, see
“Switch to Static [P mode” on page 11.”

You can also use a factory reset to load pre-configured Monarch HD settings
from a configuration file. For more information, see “Automatic configuration
page” on page 45.

To reset Monarch HD to factory defaults, press and hold the Reset button on the
device for at least five seconds. The device begins a power-up sequence during
which all LEDs illuminate. The device is ready when all LEDs turn off except the
Power ( (') ), Stream, Record, and USB port 1 LEDs.

Status LEDs

This section explains the Monarch HD status LEDs.

LED State Condition

d) Green |Device is powered.

Indicates that a streaming and/or recording error has
occurred. This includes a physical disconnect of the
network cable. The LED turns off when the error is

cleared in the Command Center, when reconnected,
i Yellow o

or when a new stream and/or recording is
successfully started. For information on how to view
and clear errors, see “Monarch HD errors” on

page 24.
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LED

State

Condition

STREAM

OFF

Indicates that Monarch HD is set to Record-only
mode. In this mode, the Stream button is disabled.

Blue
(solid)

Indicates that Monarch HD is set to stream in RTSP
or RTMP mode.

Blue
(flash)

Streaming in progress. If set to RTSP mode, the
Stream LED flashes when a client is currently
connected to the Monarch HD device. If set to RTMP
mode, the Stream LED flashes when a stream is
started using the Stream button on the device or when
using the control buttons in the Command Center. If a
disconnection occurs while in Stream-only mode, the
LED will flash faster while the device attempts to
reconnect. The LED will go back to the regular
flashing speed once it automatically establishes a new
connection.

STREAM
and
RECORD

Blue
(solid)

Indicates a disconnection in Stream and Record
mode. The LED will stop flashing upon
disconnecting (The device is not trying to establish a
new connection) and will stay this way until it is
manually restarted.

RECORD

OFF

Indicates that Monarch HD is set to Stream-only
mode. In this mode, the Record button is disabled.

Red (solid)

Indicates that Monarch HD is set to record to the
selected media.

Red (flash)

Recording in progress.

USB ports
172

OFF

USB port 1/USB port 2 is not selected as the
recording media, or Monarch HD is set to
Stream-only mode.

Red (solid)

USB port 1/USB port 2 is selected as the recording
media.

Red (flash)

Monarch HD is currently writing to the media device
connected to USB port 1/USB port 2. Do not remove
the USB device when its LED is flashing. Doing so
may result in corrupted video files.
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LED State Condition
The SD card slot is not selected as the recording
OFF destination, or Monarch HD is set to Stream-only
mode.
. .+ | The SD card slot is selected as the recording
sD CARD |Red Ol e ination.
Monarch HD is currently writing to the SD card
Red (flash) inserted in the SD card slot. Do not remove the SD

card when its LED is flashing. Doing so may result in
corrupted video files.
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Network Connection and Setup

This chapter explains how to
connect Monarch HD to a
network, and how to obtain the
Monarch HD IP address to
access the Monarch HD
Command Center. It also
explains how to update the
Monarch HD firmware.
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Introduction
The network connection and setup instructions depend on whether you’ll be
connecting Monarch HD on a network with a DHCP server, such as through a
router, or a network without a DHCP server.

If connecting to a network with a DHCP server, Monarch HD must be set to
DHCP IP mode. If your network does not have a DHCP server, Monarch HD
must be set to Static IP mode. By default, Monarch HD is set to DHCP IP mode.
Once connected to a network, the stream and record settings are specified using
the Monarch HD Command Center.

To access the Command Center, enter the Monarch’s IP address into your web
browser and press ENTER, or use the Monarch HD Utils application. On a
DHCP-enabled network, the DHCP server assigns the IP address to the Monarch,
so you must use the Monarch HD Ultils application to find the IP address. When
connecting to a network without a DHCP server, you must assign a static IP
address to Monarch. A default IP address is provided when in Static IP mode.

Monarch HD Utils application

The Monarch HD Utils application is available for both Mac OS and Windows
systems, and you can use it to do the following:

Identify Monarch devices on a network and list their [P addresses.

Open the Monarch HD web based UI (Command Center) by double-clicking
an identified device on the displayed list.

Update Monarch HD firmware (see “Updating the Monarch HD firmware”
on page 20).
Reboot MonarchHD devices (see “Device reboot” on page 11).

Download the Monarch SSL security certificate (see “Installing the Monarch
SSL certificate” on page 21).

Important Itis not recommended to simultaneously update the same Monarch
device using more than one instance of the Monarch HD Utils. Do not sever the
network connection during the update process.

Network connection and IP address

This section explains how to connect Monarch HD to a network with or without a
DHCEP server, and describes how to acquire the Monarch HD IP address.

Note If you switch the network connection while Monarch HD is powered and
the switch results in Monarch HD getting a new network IP address, you must
power cycle the device to apply the new IP address. To power cycle the device,
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use the Reset button on the Monarch HD device (see “Using the Reset button” on
page 11).

Finding the Monarch HD’s current IP address

You must know your Monarch device’s IP address to access the Command
Center. There are three ways to find the Monarch HD’s current IP address:

* You can see it displayed on an HDMI monitor at device boot up.

* You can have it automatically saved to a connected USB device when
rebooting the Monarch HD.

» Use the Monarch HD Utils application to view all connected Monarch HDs
and their IP addresses.

Displaying the IP address on an HDMI monitor
The Monarch HD’s IP address is displayed on a connected HDMI monitor at
device boot up:

1 Connect the Monarch HD to an HDMI monitor.
2 Power up the Monarch HD.

When the Monarch HD boots up, the IP address appears on the screen for
approximately 30 seconds before being replaced by the input signal.

Saving the IP address and status to USB

You can save a file containing the Monarch HD’s IP address and current status to
a USB device, making this information easily accessible (see “Status page” on
page 26).

1 Insert a formatted USB device into the USB port 2 (see “USB ports 1 and 2”
on page 7).

2 Reboot your Monarch HD. It is complete once the Warning ( A) LED stops
flashing (see “Device reboot” on page 11).

The Monarch HD IP address and status information are now saved to a text file
on the USB device.

This file can be helpful if you do not have an HDMI monitor (see ), or if you need
to share status information for your unit.

Finding the IP address with Monarch HD Utils

The Monarch HD Utils application will indicate the IP addresses of the Monarch
devices in your network. See “Connecting to a network with a DHCP server
(DHCP IP mode) for details.
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Connecting to a network with a DHCP server
(DHCP IP mode)

When connecting to a network with a DHCP server, such as through a router, the
Monarch HD IP address is assigned by the DHCP server. Although other
methods exist for obtaining the IP address of a device on a DHCP server, such as

from a DHCP-server client list, these instructions detail how to use the Matrox
Monarch HD Utils to find the IP address of your Monarch HD device.

1 Connect an Ethernet cable between Monarch HD’s LAN port and a network
port.

2 Make sure that power is supplied to Monarch HD (see “Powering Monarch
HD” on page 10).

3 Monarch HD must be set to DHCP IP mode (default). If you need to switch
the device from Static IP mode to DHCP IP mode, you can either reset the
device to factory defaults (see “Reset to factory defaults” on page 12), or set
it to DHCP using the Command Center (see “IP Setup tab” on page 55).

4 From a computer that is on the same network subnet as your Monarch HD
device, download the Matrox Monarch HD Utils application at
www.matrox.com/video/support/.

Matrox Monarch HD Utils is available for both Mac OS and Windows
systems ().

5 Double-click the downloaded file to open the Monarch HD Utils. If
Universal Plug and Play (UPnP) is enabled on your network, the utility will
automatically scan for Monarch devices. To scan manually, click the Find
All button.

All the Monarchs on the same network subnet as your computer will be
displayed, along with their IP addresses and other information.

6 Open the Command Center (see “Accessing the Command Center” on
page 20).

Tip If you have multiple Monarch HD devices, you may want to change the
name of each device for easier identification (see “Account tab” on page 52).

Connecting to a network without a DHCP server
(Static IP mode)

When connecting to a network without a DHCP server, the network does not
assign an IP address to your Monarch HD device. In this case, you must assign a
static IP address to Monarch HD and you may be required to change your
computer’s network configuration to establish a connection between your
computer and Monarch HD.
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1 Power Monarch HD (see ‘“Powering Monarch HD” on page 10).

2 Monarch HD must be set to Static I[P mode. By default, Monarch HD is set
to DHCP IP mode. You can switch Monarch HD to Static IP mode using the
Reset button (see “Switch to Static IP mode” on page 12).

3 Establish a connection between Monarch HD and your computer using one
of the following methods:

— Connect an Ethernet cable from Monarch HD’s LAN port directly to your
computer’s Ethernet port.

— Connect an Ethernet cable from Monarch HD’s LAN port to the same
network switch as your computer.

4 In order for your computer to communicate with Monarch HD, your
computer’s [P address must be in the same network range as your Monarch
HD’s IP address. If it isn’t, then you must change your computer’s IP address
accordingly. By default, the Monarch HD static IP address is set to
169.254.1.11. If you’re using the default static IP address, you must change
your computer’s IP address and subnet mask to the following:

— IP address 169.254.1.10
— Subnet mask 255.255.0.0

Note The default static IP address is designed primarily for the initial setup
of Monarch HD using a point-to-point connection (direct connection between
your computer and Monarch HD). The default IP address is not recommended
for a traditional network setting. If you wish to use Monarch HD in Static IP
mode over a network, after the initial setup we recommend that you change
the static IP address of the Monarch HD device to an address that is more
suitable to your network. You can change the static IP address in the Command
Center as specified in “IP Setup tab” on page 55.

5 Open the Command Center (see “Accessing the Command Center” on

page 20).
Note For more details on Monarch HD IP modes, see “IP Setup tab” on
page 55.

Network connection and IP address



20

Accessing the Command Center

The Monarch HD Command Center is where you specify the Monarch settings
and control the streaming and recording for a Monarch device. The Command
Center is accessible via Monarch HD Utils (see “Monarch HD Utils application”
on page 16) or by typing your Monarch HDs network IP address in the address
field of your web browser (see ‘“Network connection and IP address” on

page 16).

To access the Command Center, power the Monarch HD and connect it to an
Ethernet network, and then do one of the following:

* From your web browser, type the Monarch HD IP address in the address
field, and then press ENTER.

» With Matrox Monarch HD Utils open, double-click any of the listed devices
to open the Command Center.

The Command Center opens to configure your Monarch HD settings and control
streaming and recording (see Chapter 4, “Using the Command Center).

Note Older versions of the Monarch firmware require a “/Monarch” after
the IP address (for example, 192.168.68.11/Monarch). If you have an older
firmware version, consider upgrading to the latest firmware from the support
section of our website: www.matrox.com/video/support.

Username and password

A username and password are required to access the options and features in the
Monarch HD Command Center. Apart from the Status and About pages, which
can be viewed without logging in, a username and password are required to
access all other Command Center pages, such as the Control and Stream
Settings pages.

Logging in to the Command Center

The Command Center opens on the Status page. The Status and About pages
in the Command Center can be accessed without logging in. To access any other
page, such as the Control or Stream Settings page, click the menu item for the
page that you want to access and then enter your username and password. By
default, the username and password are set to admin. The username cannot be
changed. If you wish to change the password for your Monarch HD device, see
“Username and password” on page 24.

Updating the Monarch HD firmware

The firmware on your Monarch HD device is updated using the Matrox Monarch
HD Utils application. To view the current firmware version of your Monarch HD,
see “File Management tab” on page 60. The Matrox Monarch HD Utils is
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available for both Mac OS and Windows systems. For more information on the
Utils application, see “Monarch HD Utils application” on page 16.

A Monarch HD device’s network IP address is required to update its firmware
(see “Network connection and IP address” on page 16).

1 Power Monarch HD and connect it to an Ethernet network.

2 On a computer that is on the same network subnet as the Monarch HD that
you want to update, download the latest version of Matrox Monarch HD
Utils at www.matrox.com/video/support/.

Note It is not recommended to update the Monarch HD firmware over a
wireless network. Matrox Monarch HD Utils should be on a computer that is
connected to the network/router using a wired Ethernet connection.

3 Double-click the MatroxMonarchHD Utils.exe (Windows) or
MatroxMonarchHDUtils.app (Mac OS) file to open the Monarch HD Utils.

4 Open the Matrox Monarch HD Ultils, select the network IP Address of the
Monarch HD device that you want to update, and then click Update
Selected. If you have multiple Monarch HD devices on the network, select
the IP address for every device in the Matrox Monarch HD Ultils by clicking
Select All, and then all Monarch HD devices will update in series.

@ Important Do not disconnect the Monarch from the network or power
source during the firmware update.

The Monarch HD device will turn off and on at different times during the
update process. The update is complete when all LEDs turn off except the
Power ( (') ), Stream, Record, and USB port 1 LEDs.

Installing the Monarch SSL certificate

You can connect to the Monarch Command Center using HTTPS encryption to
prevent your username and password from being visible to someone on the
network. To connect using the HTTPS protocol, you must first install the
Monarch SSL certificate to authenticate the Command Center webpage.

Note Before you get the SSL certificate, make sure that your Monarch device
is set to the correct time zone for its location, otherwise the certificate will not be
valid. For more information, see “Date and Time page” on page 44.

1 Run the Monarch HD Utils application.

2 Click Get SSL certificate and download the certificate to your computer.

3 If you are using Mac OS, do the following (for Windows go to step 4):

a Open the certificate file MonarchSSLCertificate.crt.
The Keychain Access window opens.
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b Click Always trust, enter your Mac OS password, then click Update
Settings.
The Monarch certificate now appears in the Certificates list.
¢ Right-click the Monarch certificate and select Get Info.
d Click the Trust menu triangle to expand the menu.

e From the When using this certificate ficld, select Always Trust, enter
your Mac OS password, then click Update Settings.

4 If you are using Windows, do the following:
a Double-click the certificate file MonarchSSLCertificate.crt.
The Certificate window opens.
Click Install Certificate...
In the Certificate Import Wizard, click Next.
Select Place all certificates in the following store, then click Browse.

O o o T

From the list displayed, select Trusted Root Certification Authorities,
then click OK.

f Click Next, then click Finish.
You will be asked to confirm the installation.

g Click Yes.

The Monarch certificate is authenticated, and HTTPS encryption is now available
when connecting to the Monarch Command Center.
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Using the Command Center

This chapter describes how to
specify settings in the Monarch
HD Command Center, and

view Monarch HD information.
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Introduction

The Monarch HD Command Center is a web-based application that allows you to
configure Monarch HD settings, control streaming and recording sessions, and
import/export settings to or from other devices. You can enter the network IP
address of your Monarch HD device in your browser, or use the Monarch HD
Utils to access the Command Center (see “Accessing the Command Center” on
page 20).

Status page

The Status page in the Command Center provides a summary of the Monarch
HD status and settings, as well as any logged errors. You can view this page
without logging in; however, encoder information will display only when you
have logged in. To access the Status page, open the Monarch HD Command
Center (see “Accessing the Command Center” on page 20), and then click
Status.

ComMAND CENTER Matrox Monarch  HD

Control Settings v Device v Status

Status

Device name: Monarch HD
Control status: Single Device

Video input: 1920x1080i, 30 fps
Audio input: HDM], 48 kHz, 2 channels
Operating mode: Stream and record

Stream settings: 1280x720p, 30 fps, 3000 kby/s; 96 kb/s audio; RTSP

RTSP: rtsp://192.168.68.180:8554/Stream1
RTMP:
Record settings: 1920x1080p, 30 fps, 1000 kb/s; 96 kb/s audio;

Record media: USB 1, NTFS, 1906718MB remaining

Messages:

Clear messages

Monarch HD errors

When a streaming or recording error occurs, the A\ LED illuminates on the
Monarch HD device. Unless you receive a pop-up error when using the buttons in
the Command Center’s Control page (see “Control Page” on page 25), the error
will be logged in the Messages section of the Status page.

Note An error will not be reported if the audio connected to Monarch HD’s
analog audio input is lost or missing. If this occurs, the stream and/or recording
continues but will not contain audio.
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Viewing and clearing errors

Streaming and recording errors that don’t appear as a pop up error on the
Control page are instantly logged in the Messages section of the Status page.
The Status page displays the errors pertaining to that Monarch HD device only.

To monitor streaming and/or recording when controlling multiple devices (see
“Control streaming and recording for multiple devices on the same network™ on

page 28), we recommend that you open the Command Center for each Monarch
HD device.

When you click the Clear messages button on the Status page, the logged
errors are deleted from the list and the /\ LED turns off. The /\ LED will also
turn off if you successfully start a new stream and/or recording.

Note Powering off or resetting Monarch HD will clear all errors from the
device.

Control Page

The Control page lets you control the streaming and recording for your Monarch
HD device. If you have other Monarch HD devices connected to the same
network, you can also control the streaming and recording for up to four other
devices at the same time. You can also use the Stream and Record buttons
directly on a Monarch HD device to stream and record, however, you will not be
able to control other devices on the network.

To access the Control page, open the Monarch HD Command Center (see
“Accessing the Command Center” on page 19), and then click Control.

CommanD CENTER Matrox Monarch HD

Control Settings v Device v Status

Control

L JOIS

Disable Stream and Record buttons on this Monarch HD device
Control multiple Manarch HD devices

Active IP Address Device Name
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Disabling Stream and Record buttons on the

Monarch HD device

You can disable the physical Stream and Record buttons on the Monarch HD
device to prevent someone from inadvertently stopping a streaming or recording
session. This option only applies to the Monarch HD you are connected to, and
not other Monarch HD devices you may be controlling.

To disable the Stream and Record buttons:
1 In the Command Center, click Control.
For more information, see “Accessing the Command Center” on page 19.
2 Select Disable Stream and Record buttons on this Monarch HD
device.
The Stream and Record buttons on the Monarch HD device are disabled.

Note This button disable feature is off by default and, when required, would
also need to be performed after a factory reset.

Enabling multi-device control

This section details how to enable multi-device control of up to four other devices
in the Command Center (see “Control streaming and recording for multiple
devices on the same network™ on page 28).

1 In the Command Center, click Control.
2 Select Control multiple Monarch HD devices.

3 For each Monarch HD device that you want to control, enter the network IP
address of the device. Click Scan after entering the IP address to verify if
the device can be found on the network. For information on acquiring a
Monarch HD’s IP address, see “Network connection and IP address” on
page 16.

4 Activate or deactivate the control for a Monarch HD device by selecting or
clearing the device’s Active box.

Control buttons
The following table details the different states of the control buttons in the
Command Center.

Note Depending on the selected operating mode (see “Monarch HD operating
modes” on page 30), stream or record functionality may not be available.
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Function

This button indicates that the Monarch HD device is
set to stream in RTMP mode. Click this button to

Start record

Click this button to start recording the input source
connected to Monarch HD’s HDMI input. If
controlling multiple Monarch HD devices, those
devices will begin to record their input sources as

Start start streaming the input source connected to
stream |Monarch HD’s HDMI input. If controlling multiple
(RTMP) |Monarch HD devices, those devices set to stream in
RTMP mode will begin to stream their input sources
as well.
This button indicates that the Monarch HD device is
currently streaming in RTMP mode. Click this
Stop button to stop streaming. If controlling multiple
@ stream |Monarch HD devices, those devices set to stream in
(RTMP) |RTMP mode will stop streaming as well. The
devices on the network that are streaming in RTSP
mode will continue to stream.
This button indicates that the Monarch HD device is
currently set to stream in RTSP mode. In RTSP
Streaming |mode, the unit delivers stream data once a client
(RTSP) |connects to Monarch HD using the RTSP streaming
protocol, and therefore does not require you to click
the Stream button to start streaming.
Indicates that Monarch HD is currently set to
e Stream Record-only operating mode.
disabled

well.

Stop record

This button indicates that the Monarch HD device is
currently recording its input source. Click this
button to stop recording. If controlling multiple
Monarch HD devices, those devices will stop
recording their input source as well.

> JKS

Record
disabled

Indicates that Monarch HD is currently set to
Stream-only operating mode.
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Button Function

This button lets you start simultaneous streaming
and recording, and is available only when the
Monarch HD device is set to stream in RTMP mode.
Click this button to start streaming and recording
Start the input source connected to Monarch HD’s HDMI
stream |input. If controlling multiple Monarch HD devices,
(RTMP) |those devices will begin to stream and record their
and record |input sources as well. To stop streaming and
recording, you can either stop streaming and
recording at the same time, or use the separate Stop

stream and Stop record buttons to stop each process
separately.

Click this button to simultaneously stop streaming
stream and recording the input source connected to
Monarch HD’s HDMI input. If controlling multiple
(RTMP) . . .
Monarch HD devices, those devices will stop
and record ) . .
streaming and recording their input sources as well.

Stop

The stream and record button is disabled. This
Stream and .
button appears when Monarch HD is currently
record . . .
button either streaming or recording, or when Monarch HD
disabled is set to Stream-only or Record-only operating

mode.

Control streaming and recording for a single
device

To control streaming and recording for a single Monarch HD device, you can use
the following two methods:

¢ Use the control buttons in the Command Center (see “Control buttons” on
page 26).

» Use the Stream and Record buttons on the Monarch HD device (see Chapter
2, “Matrox Monarch HD Hardware and Connections”).

Control streaming and recording for multiple
devices on the same network

Monarch HD allows you to start and stop the streaming and recording for up to
five devices on the network at the same time. Each device streams and records the
input source connected to its HDMI input based on its own stream and record
settings.
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To control multiple devices, you must use the control buttons (see “Control
buttons” on page 26) in the Command Center instead of the Stream and Record
buttons located on a Monarch HD device, which control the streaming and
recording for that device only.

You can control multiple Monarch HD devices from any of the devices on the
network. When enabling the control of multiple devices in a device’s Command
Center, that device becomes the primary device and the devices being controlled
become secondary devices. The control buttons in the Command Center of the
primary device can then be used to control the other devices on the network. You
can have more than one primary device on the network, with each primary device
controlling its secondary devices. For example, if you have three Monarch HD
devices on the network, you can set device one to control devices two and three,
and you can also set device two to control devices one and three.

Settings tab

The Settings pages in the Command Center lets you set Stream, Record and
Audio settings for the Monarch HD device. If you have multiple Monarch HD
devices connected to the same network, you can also control the streaming and
recording of multiple devices from one device's Command Center (see “Enabling
multi-device control” on page 26).

Settings tab



30

Important To save changes made on a Settings page (Stream, Record or
Audio), you must click the Apply button. If you leave a Settings page before
applying the settings, all changes will be lost.

CoMMAND CENTER Matrox Monarch’

Control Settings v Device w

0 Mode
r Stream only Record only  ® Stream and record

Stream Settings s Apply
Profile:
[empty]
[empty]
[empty]
[smpty] Profile name:
Load | Save Loaded profile: None
Preset: | None v Use stream settings for recarding
rAdvanced Settings-
Width: 1280 profile: | Main M
Use input resolution
Height: 720 Frame slices: |1 ¥
Frame rate: | Full v | (Video input: 1920x1080i, 30 fps) Deblocking filter:
Target video data rate (kb/s): [1200 average 1080 min. |1320 max.
GOP sire: 256 frames
Include audio: ¥
® RTSP RTMP
Stream name: | Stream1
Port: |B554
Stream URL: rtsp://192.168.68.193:8554/Stream1

Remarks

* Unless a specific record duration limit was set in the record settings,
Monarch HD limits the duration of each recording to four hours and fifty
minutes. The recording will automatically stop when the duration limit is
reached.

* When a recording is stopped, it will take a few seconds for Monarch HD to
finalize the file. If recording to a USB device or SD card, the USB/SD card
LED continues to flash during the finalization process. To avoid corrupted
video files, do not remove the USB device or SD card when its LED is
flashing
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Monarch HD operating modes
To ensure the highest possible streaming/recording video data rates based on
your needs, Monarch HD offers three operating modes:

* Stream only This mode disables the record functionality for your
Monarch HD. In this mode, the maximum average video data rate for
streaming is set to 20 000 kb/s.

* Record only This mode disables the stream functionality for your
Monarch HD. In this mode, the maximum average video data rate for
recording is set to 30 000 kb/s.

» Stream and record This mode allows you to simultaneously stream and
record with your Monarch HD device. In this mode, the maximum average
video data rate for streaming is 10 000 kb/s, and the combined maximum
average video data rate for streaming and recording is 30 000 kb/s. For
example, if the average video data rate for streaming is set to the maximum
value of 10 000 kb/s, the maximum average video data rate for recording is
20 000 kb/s.

Specifying the operating mode
You can set the Monarch HD operating mode in either the Stream Settings
page or Record Settings page.

Important Changes made to the operating mode are automatically and
instantly applied. The Apply button in the Stream Settings page and Record
Settings page does not apply to the operating mode setting.

Profiles
Monarch HD lets you save four stream profiles and four record profiles, which
you can load at any time. Saving a new profile saves the current settings.

Loading a profile
1 From the Profile list, select a profile.

2 Click Load. The loaded profile will appear next to Loaded profile. If a
change is then made to any of the settings, “(modified)” will appear next to
the loaded profile name.

Saving a profile
1 Specify your settings.

2 From the Profile list, select an empty profile, or a previously saved profile
that you want to overwrite.

3 Type a Profile name.
4 Click Save.

Settings tab
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Encoding
Specify the following H.264 encoding settings for streaming or recording.

Presets

Monarch HD comes with predefined resolution presets that you can use to
quickly set your encoding settings. A preset automatically sets all encoding
settings, however, you should verify that the preset frame rate is appropriate for
your encoding. You can also use a preset as a starting point when specifying your
encoding settings. To use a preset:

1 Select the desired preset from the Preset list.
2 Specify the Frame rate setting as detailed in “Frame rate” on page 32.

Note Some presets may not be compatible for use with all CDNs. To avoid
streaming issues, ensure that a preset’s settings, such as video resolution and
video data rate, are supported by your CDN.

Record presets
Monarch HD provides record preset types:

* HQ Used for creating recorded files that will be edited for high-quality
production.

* Proxy Suitable for creating recorded files at smaller file sizes. This is
especially useful when creating files for previewing or archiving, or when
recording long-duration content.

* YouTube Used for creating recorded files for delivery to most video on
demand (VOD) streaming applications.

Use stream settings for recording
In Stream-and-record operating mode, select the Use stream settings for
recording option to use the stream encoding settings also for recording.

Video resolution

Select the resolution by entering values for the Width and Height. You can also
select Use input resolution to stream or record at your input source’s original
resolution. Monarch HD does not support upscaling the input source.

Note In Stream-and-record operating mode, if the current record encoding
resolution exceeds a width of 1280 and/or height of 720, and you want to stream
at a resolution greater than 1280x720, the stream and record settings must use
the same encoding settings. In this case, you must select the Use stream
settings for recording option.

Frame rate
You can choose to stream or record at your input source’s Full frame rate, or at a
Half or a Quarter of your source’s frame rate.
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The Monarch HD does not support upscaling the resolution or frame rate of the
input source. If Full is selected from the Frame rate list, the frame rate will

automatically be set to Half of the input source’s frame rate after clicking Apply.

Target video data rate

Enter the target average video data rate for your session. When entering an
average data rate, the minimum and maximum data rates are automatically set
to 90% and 110% of the average data rate, respectively. The default minimum
and maximum values are suitable in most instances, however, you can change the
minimum and maximum values to suit your needs. The maximum average video
data rate for streaming or recording depends on the selected operating mode (see
“Monarch HD operating modes” on page 31). Monarch HD uses a variable data
rate when encoding.

GOP size (streaming)

Enter the GOP size (distance between I frames) to which you want to encode
your input source for streaming. Monarch HD uses the IP pattern when encoding
for streaming. For example, a GOP size of 10 creates a GOP structure of
IPPPPPPPPPI.

Your CDN may use the term “keyframe interval” instead of GOP size. Although
related to the GOP size value, the keyframe interval is expressed in seconds and
refers to the length of time between anchor frames. To set the Monarch’s GOP
size based on the keyframe interval required by your CDN, use the following
formula:

* Monarch GOP Size = Encoding frame rate x Required keyframe interval.

When determining the “Encoding frame rate”, you must also account for the
Frame rate settings Full, Half, or Quarter that Monarch is currently using (see
“Frame rate” on page 32).
For example, assume the following scenario:

* Your input frame rate is 30 fps (e.g. 1920 x 1080 @30 fps).

* Your encoding Frame rate is set to Quarter.

* Your CDN requires a keyframe every 2 seconds.

Given this scenario, you should set your Monarch GOP size to 15 (15 = 7.5 x 2).

GOP structure (recording)

Enter the GOP size (distance between I frames) and distance between P frames to
which you want to encode your input source for recording. Monarch HD uses the
IBP pattern when encoding for recording. For example, a GOP size of 15 and a
distance between P frames of 3 creates a GOP structure of
IBBPBBPBBPBBPBBI
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Include audio

Select Include audio to stream or record the selected audio source along with
the video. Monarch HD uses the AAC audio format. Clear this option if you do
not want to include audio in your stream or recording. For more information on
configuring audio settings, see “Audio source” on page 40 and “Specifying audio
input settings” on page 28.

Advanced settings
* Profile Set the H.264 encoding profile for your stream or recording to

either Baseline, Main, or High. Typically, High profile provides the best
image quality and is suitable in most instances. However, depending on the
decoder used when viewing the stream or recorded file, such as with mobiles
devices, a Main or Baseline profile may be required.

Frame slices You can choose to slice each frame into 2, 4, or 8 sections
when encoding, or you can select 1 to encode the frame as a whole. Slicing
each frame when encoding the video for streaming, or recording may be
useful when a multi-slice decoder device is used to view the stream or
recorded file.

Deblocking filter Select this option to remove blockiness from the
encoded video when streaming, or for recording. This option is especially
useful when a low video data rate is required.

Specifying Stream settings

To access the stream settings, open the Monarch HD Command Center (see
“Accessing the Command Center” on page 20), and then choose Settings >
Stream.
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Note The Streaming settings cannot be modified when Monarch HD is set to
Record-only mode (see “Monarch HD operating modes” on page 31).
—Streaming

(*) RTSP RTMP
Stream name:  Streaml
Port: 18554
Username:

Password:

Stream URL: rtsp://192.168.68.202:8554/Stream1

—Streaming
RTSP (&) RTMP
XML file: | Choose File | No file chosen Load Clear
Server URL:

Stream name:

Monarch HD provides options for using RTSP and RTMP streaming protocols
for use on Adobe Media Servers, Wowza Media Servers, software video players
such as QuickTime and VLC, or any of the popular Co ntent Delivery Networks
(CDNs), such as YouTube Live and Ustream (RTMP mode only). In RTSP mode,
Monarch HD acts as a streaming server to which clients can connect via a media
server or software video player that supports the RTSP streaming protocol.

If you want to stream to more than a handful of clients, we recommend using a
dedicated media server to send streams to clients. In RTMP mode, Monarch HD
can send stream data to a CDN or media server that supports the RTMP
streaming protocol.

@ Important To save changes made on the Stream Settings page (Stream,
Record or Audio), you must click the Apply button. If you leave the Stream
Settings page before applying the settings, all changes will be lost.

Using the RTSP streaming protocol
1 Select RTSP.
2 Enter a Stream name.
3 Enter the network Port through which the clients will connect.
4

A Stream URL is automatically generated based on your settings. Provide
this URL to a client to connect to your Monarch HD network via a Wowza
Media Server or software video player that supports the RTSP streaming
protocol.

Specifying Stream settings



36

Remarks
* As soon as you apply RTSP stream settings, Monarch HD is ready to deliver

RTSP streams to clients, and will begin streaming data once a client connects
to Monarch HD using the RTSP streaming protocol. Monarch HD will
continue to do so until it is no longer in RTSP mode. There is no need to use
the Stream button located on the Monarch HD device or the Stream button in
the Command Center to start streaming.

If you get choppy video when streaming to VLC media player, you must
enable the Real-time Transport Protocol (RTP) in VLC. Proceed by doing
one of the following:

— Windows Open the VLC media player, open Tools > Preferences,
and then choose the Input / Codecs tab. In the Network section, select
RTP over RTSP (TCP).

— Mac Open the VLC media player, open VLC > Preferences, and then
choose the Input / Codecs tab. In the Codecs / Muxers section, select
Use RTP over RTSP (TCP).

Using the RTMP streaming protocol
1 Select RTMP.

2 Specify the destination Server URL and Stream name provided by your

CDN or server administrator. If your CDN provides a streaming XML file, or
when using Wowza Streaming Engine Manager, you can load the streaming
XML file instead of entering the server URL and stream name. To do so,
click Browse... to select the file, and then click Load. When loading a
streaming XML file, just the destination information (server URL and
stream name) from the streaming XML file will be loaded. If the streaming
XML file contains encoding information, those settings will not be loaded.
Clear the Server URL field to remove the XML file. Clear the Stream
name field to remove the loaded streaming XML file.

Important Please note the following:

— If the stream name, username, or password is included in the stream URL,
do not enter the information in the respective text boxes.

— Streaming XML files are not the same as Monarch HD configuration
XML files.

If your Flash-based server or CDN uses the “ModuleRTMPAuthenticate”
method for RTMP authentication, a username and password is used for
authentication, however, username and password information is not included
as part of the stream URL or streaming XML file. In this case, you must
enter the stream Username and Password in the text boxes provided.

Start streaming the Monarch HD input source to a CDN or media server as
detailed in “Control streaming and recording for a single device” and
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“Control streaming and recording for multiple devices on the same
network”.

Specifying Recording settings

To access the record settings, open the Monarch HD Command Center (see
“Accessing the Command Center” on page 20), and then choose Settings >
Record.

Note The Recording settings cannot be modified when Monarch HD is set to
Stream-only mode (see “Monarch HD operating modes™ on page 31).

—Recording
Media: | USB 1 : | ™ Maximum file duration: |60 minutes
File type: @Mov MP4
Path and filename: Filel
Domain:

Usermname:

Password:

.

The Record Settings page in the Command Center lets you set the record
settings for the Monarch HD device. Monarch HD provides settings for recording
your input source for video on demand (VOD), high-quality editing, and
archiving/previewing purposes. Content can be recorded to MOV and MP4 file
formats on a FAT32 or NTFS file system. Because FAT32 limits the recording
file size to 4 GB, you must use an NTFS drive if your recorded file will be greater
than 4 GB. If controlling multiple devices, each device on the network records
based on its own record settings. For details on how to start/stop recording, see
“Control streaming and recording for a single device” and “Control streaming
and recording for multiple devices on the same network”.

For approximate recording file sizes based on the average video data rate and
recording duration, and approximate maximum file durations given the average
video data rate and available disk space, see “About page” on page 50.

Important To save changes made on the Record Settings page (Stream,
Record or Audio), you must click the Apply button. If you leave the Record
Settings page before applying the settings, all changes will be lost.

Specify the following settings for recording.

Specifying Recording settings
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Media

Select the Media to which you want to record your input source. You can choose
either a USB or SD card slot on the Monarch HD device, or a network location.
For more information on using USB devices or SD cards, including the known
limitations of each, see the sections “USB ports 1 and 2” on page 7, and “SD
card” on page 8.

Maximum recording duration

Enter a Maximum recording duration to set an overall time limit for your
recording session. The session will automatically end when this limit is reached,
or when the selected storage media is full (whichever occurs first). If you enter a
value of 0, the recording session will continue indefinitely, and will stop only
when your storage media is full.

The maximum file duration can include multiple files. For example, if you
specify a five-hour recording duration, but you have entered a file switching
duration (see “File switching duration” on page 38) of one hour, your overall
recording session will stop after four hours and fifty minutes (assuming the
storage media has enough space), but Monarch HD will create five individual
hour-long files.

File switching duration

Enter a File switching duration to separate your recording session into more
than one file at predetermined intervals. For example, if you enter a duration of
30 minutes, Monarch HD will close the current file and start recording to a new
file every 30 minutes.

The size of the created files (in approximated MBs) is displayed next to the
duration. The file size adjusts depending on the video data rates you set in the
encoding options (see “Target video data rate” on page 33).

Remarks
* The maximum file switching duration you can set is four hours and fifty
minutes.

» If you enter a file switching duration of 0, Monarch HD will automatically
switch to a new file every four hours and fifty minutes. This is a precaution
that will avoid possible data loss that may occur from having files that are
too large.

* On FAT32 storage media, file switching will occur automatically after 4 GB.
This is a limitation of the FAT32 file system architecture. You can stop
recording at any time, either by using the control buttons in the Command
Center (see “Control buttons” on page 26), or the Stream and Record buttons
on the Monarch HD device (see “Streaming and recording” on page 6).
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File type
Select the type of file that will be recorded. You can create either an MOV or
MP4 (MPEG-4) file.

Path and filename

Specify the destination and filename for your recording based on your recording
destination. When specifying the path, all folders in the path must already exist.
Monarch HD will not create new folders. Each recorded filename contains the
base name, date, time, an automatically incrementing 5-digit number, and file
type, using the following naming convention:

Basename-[YYYY-MM-DD_HH-MM-SS].00001.mov or .mp4.

For more information on how to set up shared folders for Windows or Mac OS,
see Appendix B, “Sharing a network folder,” on page 53.

Important Blank spaces are not supported in the base name. Use underscores
in place of blank spaces. For example, enter Recordingl_Stagel instead of
Recordingl Stagel as the base name for the file.

Domain, username, and password

When recording your source input to a network location (see “Media” on

page 38) and Monarch HD is not on the same domain as the network, enter the
network domain. If required, also enter the Username and Password that is
used to access the network.

Audio Settings page

®

The Audio Settings page in the Command Center lets you set the audio input
source that will be used for streaming and recording, and the audio sample rate
for your analog audio source. If controlling multiple devices, each device on the
network streams and records the audio based on its own audio settings.

Important To save changes made in the Audio Settings page, you must click
the Apply button. If you leave the Audio Settings page before applying the
settings, all changes will be lost.

Audio Settings page
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To access the audio settings, open the Monarch HD Command Center (see
“Accessing the Command Center” on page 19), and then choose Settings >
Audio.

ComMAND CENTER Matrox Monarch  HD

Control Settings v Device v Status

Audio Settings Apply

Audio source: [HDMI (ch 1and2) ¥
Analog audio sample rate: (48 ¥ kHz

Audio bit rate: | 128 ¥ |kb/s

Audio source

Select the Monarch HD audio input source that will be used for streaming and
recording. Monarch HD supports two audio channels for streaming and
recording. You can choose to use either the first two audio channels from your
HDMI input source, or the stereo audio source connected to Monarch HD’s
analog audio input (see “Video/audio inputs and outputs” on page 9). Monarch
HD uses the AAC audio format for streaming and recording. To monitor the
selected audio source, you can use either the HDMI or analog audio output.

Note You can choose whether or not to include audio when streaming and
recording in the stream and record settings, respectively.

Analog audio sample rate

If using analog audio, select the desired sample rate for your analog audio input
source. If you are using an HDMI audio input source, this option is unavailable
(appears dimmed) because the sample rate is determined by the digital signal.

The default setting is 48 kHz, but you can choose any of the available options.
The analog audio input is converted to the selected sample rate before encoding.
Selecting the highest sample rate provides the best audio quality, but also
increases the total bit rate required to maintain this quality for streaming and/or
recording.

Audio bit rate

Select the bit rate at which you want to stream the audio. This setting applies to
both the stream and record settings.

Note (Analog audio only) To select the 32 kb/s bit rate, you must first select
22.05 kHz for the Analog audio sample rate.

Chapter 4, Using the Command Center



41
Device tab

The Device tab is where you access various settings related to all aspects of the
Monarch HD and its operation. A username and password are required to access
the options and features of the Device.

Account page

The Account page in the Command Center is where you give a descriptive name
to your Monarch HD device and change your Monarch HD password. To access
the Account page, open the Monarch HD Command Center (see “Accessing the
Command Center” on page 20), and then choose Device > Account.

CommaND CENTER Matrox Monarch  HD

Control Settings v Device v Status

Account

Device name:
Monarch HD
Change

Current password:

New password:

Confirm new password:

Change

Device nhame and password

By default, the device name is set to Monarch HD. You can give a unique name to
each Monarch HD device for easy identification within the Command Center and
the Matrox Monarch HD Utils application (see “Monarch HD Utils application”
on page 16). This is especially useful when you have multiple Monarch HD
devices on the same network. To change the name of your Monarch HD, type the
desired name in the Device name box, and then click Change.

By default, the Monarch HD username and password are set to admin. The
device username cannot be changed, however, we do suggest that you change the
device password. To change the Monarch HD password, enter the current and
new passwords and then click Change. For information on resetting the
password to factory default, see “Reset to factory defaults” on page 12.

Device tab
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IP Setup page

The IP Setup page in the Command Center lets you switch the Monarch HD IP
mode between DHCP and Static. By default, Monarch HD is set to DHCP mode.

@ Important Changing the IP mode will end the current Command Center
session. To access the Monarch HD Command Center again, you’ll need to enter
a different Monarch HD IP address in your browser’s address field. If switching
to Static mode, you may also be required to change your computer’s network
configuration. For information on obtaining the Monarch HD IP address and
accessing the Command Center in DHCP or Static mode, see Chapter 3,
“Network Connection and Setup.”

To access the IP Setup page, open the Monarch HD Command Center (see
“Accessing the Command Center” on page 20), and then choose Device > IP
Setup.

CommanD CENTER Matrox Monarch HD

Control Settings « Device « Status

IP Setup Apply

® DHCP
Static
1P address: |192.168.68.193

Subnet mask: |255 255 2550
Gateway:
DNS server:

I Display this Monarch HD on the network as a UPnP device

Setting the IP mode to DHCP
Set Monarch HD to DHCP IP mode when connecting to a network with a DHCP
server, such as through a router.

1 Select DHCP.

2 Click Apply.

3 See “Network connection and IP address” on page 16 for instructions on
how to connect Monarch HD to a network with a DHCP server, and how to
acquire the Monarch HD network IP address to access the Command Center.
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Setting the IP mode to Static

Set Monarch HD to Static IP mode when connecting to a network without a
DHCP server.

1 Select Static.

2 Enter a static IP address for your Monarch HD. Unless you change this
address, the default static IP address will be used (169.254.1.11). If you reset
the device in Static IP mode (see “Switch to Static IP mode” on page 11), the
static IP address reverts to default.

Note When connecting multiple Monarch HD devices on the same network,
each Monarch HD device must have a unique network IP address.

3 Enter the Subnet mask on your network to which Monarch HD is
connected. By default, the subnet mask is set to 255.255.255.0.

4 Enter the Gateway IP address and DNS server.

5 Click Apply.

6 See Chapter 3, “Network Connection and Setup” for instructions on how to
connect Monarch HD to a network without a DHCP server, how to change
your computer’s network configuration to establish a connection between

your computer and the Monarch HD device, and how to access the
Command Center.

Preventing Monarch HD from appearing as a

UPNP device on the network

The Monarch HD uses the Simple Service Discovery Protocol (SSDP) to
broadcast itself as a Universal Plug and Play (UPnP) device. This means that it
will appear in Windows Explorer (not visible in Mac OS) as if it were a a printer,
external hard drive, or similar UPnP device.

This feature is enabled by default, and makes it easier to find the Monarch HD on
a network if you do not know the device IP address. However, for security
reasons you may not want the Monarch HD to appear on your network for
anyone to see. If so, you can disable SSDP to hide the Monarch HD from
appearing as a UPnP device.

—> To prevent the Monarch HD from appearing:

1 Access the Monarch HD Command Center (see “Accessing the Command
Center” on page 20).

2 Choose Device > IP Setup.
3 Clear Display this Monarch HD on the network as a UPnP device.
4 Click Apply.

IP Setup page



44

The Monarch HD will no longer be visible in Windows Explorer as a UPnP
device. You may need to restart Windows Explorer for Monarch HD to no longer
appear on the network.

Note By using this option, this Monarch device will not automatically appear
on the Monarch HD Utils list of connected devices. You must use the Find All
button for the Monarch HD to appear.

Date and Time page

The Date and Time page in the Command Center lets you set the date and time
for your Monarch HD device. You can set the date and time manually or
automatically by using an NTP server. The date and time are used in the naming
of the recorded files (see “Path and filename” on page 39).

@ Important To save changes made in the Date and Time page, you must click
the Apply button. A Monarch HD hardware reboot is required to apply the
changes. If you leave the Date and Time page before clicking Apply, all
changes will be lost.

To access the Date and Time page, open the Monarch HD Command Center
(see “Accessing the Command Center” on page 20), and then choose Device >
Date and Time.

CoMMAND CENTER Matrox Monarch HD

Control Settings v Device v Status

Date and Time Apply

@ Manual
Time: [ 00 #|: |30 ¢|:|56 ¢

Date: |12/9/2013

Automatic
NTP server: time.nrc.ca
Time zone: | (GMT-12:00) International Date Line West
Current date and time: 12/09/2013, 00:30:56

Setting the date and time manually
1 Select Manual.
2 Set the Time, and enter a Date in the format DD/MM/YYYY, or click [75] to
select a date from the calendar.

3 Click Apply. You’ll be notified that Monarch HD will be rebooted in order
to apply the changes.

Setting the date and time automatically
Setting the date and time automatically requires a local or public NTP server
address. An Internet connection is required to use a public NTP server.
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1 Select Automatic.

2 Enter a local or public NTP server address. The default NTP server address
is time.nrc.ca.

3 Select a Time zone from the list. The current date and time associated with
the selected NTP server and time zone are displayed next to Current date
and time.

4 Click Apply. You’ll be notified that Monarch HD will be rebooted in order
to apply the changes.

Automatic configuration page

The Automatic configuration page in the Command Center is where you can
export the current Monarch HD settings to an XML file (called the Monarch HD
configuration file), import settings from a previously-created configuration file,
or import settings from the same XML file hosted on a web page.

When you have a Monarch HD configuration file, you can copy it to a USB
device, connect the device to USB port 2, and then perform a factory reset to
automatically load the settings. For more information on performing a factory
reset, see “Network connection and IP address” on page 16.

The option to boot up Monarch HD with all settings loading automatically from a
USB device, or loading settings from a web page URL at device reboot, allows
you to deploy other Monarch devices without logging in to the Command Center.

To access the Automatic configuration page, open the Monarch HD Command
Center (see “Accessing the Command Center” on page 20), and then choose
Device > Automatic configuration.

COMMAND CENTER Matrox Monarch HD

Control Settings v Device « Status

Automatic configuration

Load settings from a Monarch HD configuration file:

Browse.

Load settings from a web page URL:

|hnp:ff ‘ [ Load settings at device reboot

Export current settings to a Monarch HD configuration file:

Generate file
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Loading settings from a Monarch HD
configuration file

You can import Monarch settings from a previously-generated Monarch HD
configuration file. The file must be located on your computer or somewhere that
is accessible from your computer (see “Generating a configuration file” on

page 46).

1 Go to the Automatic configuration page of the Command Center.

2 Under Load settings from a Monarch HD configuration file, click
Browse.

3 Select the file you want to load.
4 Click Load.

Your Monarch settings will now match those of the chosen configuration file.

Loading settings from a web page URL

You can import settings from a specific web page that is hosting the configuration
file generated in the Command Center (see “Generating a configuration file”” on
page 46). This option is particularly useful when there is a need to oversee the
Monarch HD operation from a central control environment. You can set bit rates
and destinations by managing a web page instead of logging into the Monarch
HD Command Center.

1 Go to the Automatic configuration page of the Command Center.

2 Inthe Load settings from a web page URL field, type the URL address of
a page hosting the configuration parameters.

3 Click Load.

4 (Optional) Select Load settings at device reboot if you want to have your
Monarch HD automatically load the settings from the specified URL the
next time it boots up.

Your settings will now match those of the chosen configuration file.

Note With Load settings at device reboot selected, you only need to
reboot/reset your Monarch HD and it checks the specified URL for updated
settings.

Generating a configuration file

You can export your current settings as a Monarch HD configuration file, which
you can then save to your computer, to a USB device connected to your
computer, or to a network drive. You can then use the configuration file to
configure other Monarch devices.

Note You cannot save to a USB device connected to the Monarch HD.
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1 Go to the Automatic configuration page of the Command Center.

2 Under Export current settings to a Monarch HD configuration file,
click Generate file.

3 Select a save location. Do not change the filename (MonarchSettings.xml) if
you plan to automatically configure a Monarch from a USB device (see
“Automatically importing Monarch settings on factory reset” on page 47).

The Monarch HD configuration file is created, and contains all the Monarch
settings as XML parameters.

Automatically importing Monarch settings on
factory reset
On factory reset, the Monarch HD can automatically import configuration

settings from a Monarch HD configuration file that is on a USB device connected
to the Monarch’s USB port 2.

1 Copy the Monarch HD configuration file to a USB device (see “Generating a
configuration file” on page 46).

Note The configuration file must have the original filename, given by the
Monarch HD when the file was generated (MonarchSettings.xml).
2 Connect the USB device to the Monarch HD's USB port 2 (see “USB ports 1
and 2” on page 7).

3 Perform a factory reset by pressing and holding the Reset button on the
device for at least five seconds (see “Reset to factory defaults” on page 12).

The Monarch HD boots up with your settings loaded.

Note For more information on Monarch configuration files, including
generating or editing configuration files, consult the Matrox Monarch HD Dev
Tools Reference Guide, which is provided in PDF format in the Matrox Monarch
HD Support section of our website at www.matrox.com/video/support.
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Pairing page
The Pairing page in the Command Center allows you to link your Monarch
device with third-party live video web services such as YouTube Live and
Facebook Live. Once paired to the service, Monarch can stream (RTMP) directly
to these services with no additional configuration required.

Note Your Monarch must be connected to a network that has access to the
internet, and that is not blocked by a proxy server.

To access the Pairing page, open the Monarch HD Command Center (see
“Accessing the Command Center” on page 20), and then choose Device >
Pairing.

COMMAND CENTER Matrox Monarch  HD

Control Settings v Device = Status

Pairing

YouTube Live Facebook Live
User device code: l:l\fen'ﬁcation URL User device code: l:lveriﬂcat\on URL

To pair your Monarch device with a third-party service, follow the steps below:

1 Go to the Pairing page of the Command Center.

If your Monarch is connected to a network that has internet access, you will
see a value in the User device code field. This is a randomly generated
code that identifies your Monarch to the third-party service.

If you do not see a code, or the Verification URL is not clickable, check your
internet connection and/or proxy server settings.

2 Select the User device code you want to verify with YouTube Live or
Facebook Live and copy it to your clipboard.

3 Click Verification URL to be redirected to the third-party verification page.

4 Paste your User device code and submit it where indicated to add your
Monarch device to the third-party service.

@ Important For Facebook Live pairing, you must also select the default
stream privacy setting (Public, Friends, or Private). The Public setting is
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recommended. When selecting your individual stream privacy later on in
step 8, you must select a stricter setting than the default you select in this
step because Facebook will ignore less strict settings for individual streams.
For example, if you set your default privacy to Public (as recommended),
you can then select Private or Friends in step 8. But if you select Private as
the default, and you then try to select Public or Friends in step 8, Facebook
will ignore that setting and keep the default privacy setting (i.e. Private).

5 After the third-party has added your Monarch device, go back to the Pairing
page in the Command Center.

6 Click Verify.

Your Monarch device has been verified for live streaming with the
third-party service.

7 Go to the Stream page of the Command Center.

8 Under RTMP, select you will now see Default, YouTube and/or Facebook
as selectable options.

- .
Streaming

ORTsP ®@RTMP
YouTube
XML file: Facebook Browse...

— If you want to stream to YouTube, select YouTube, then go to step 9.
— If you want to stream to Facebook Live, select Facebook, then select
your default Stream privacy settings (Public, Friends, or Private).

Please note that this setting will only apply if it is stricter than your default
privacy setting (for more information, see step 3). If this setting is less
strict than your default privacy setting, Facebook will ignore it and apply
your default privacy setting instead.

9 Click Apply.

Monarch pairing with third-party services is complete. When you next start an
RTMP stream, it will stream live to your third-party account or channel.

Pairing page
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About page
The About page in the Command Center lets you see the current firmware
version of your Monarch HD device, provides a link to the Monarch HD
documentation, and displays the Matrox Limited Warranty for Monarch HD.
This page can be viewed without logging in.

To access the About page, open the Monarch HD Command Center (see
“Accessing the Command Center” on page 20), and then choose Device >
About.

COMMAND CENTER Matrox Monarch  HD

Control Settings w Device v Status

About

Device firmware version:
Documentation: Click here for the Matrox Monarch HD documentation.
Hardware warranty: Click here for the Matrox Menarch HD warranty.

Third-party licenses: Click here for the list of open source content and licenses.

Matrox Software License Agreement

MATROX SOFTWARE LICENSE AGREEMENT (HEREAFTER REFERRED TO AS LICENSE) N
THIS IS A LEGAL AGREEMENT BETWEEN THE LICENSEE AND MATROX ELECTRONIC SYSTEMS LTD "MATROX") CONCERNING THE USAGE OF THE MATROX SOFTWARE. BY
DOWNLOADING, INSTALLING, COPYING, ACCESSING, CLICKING ON AN "ACCEPT” BUTTON, OR OTHERWISE USING THE SCFTWARE, THE LICENSEE AGREES TO THE TERMS OF
THIS LICENSE. IF YOU ARE ACCEPTING THESE TERMS ON BEHALF OF YOUR COMPANY, ORGANIZATION, EDUCATIONAL INSTITUTICN, OR AGENCY, INSTRUMENTALITY, OR
DEPARTMENT OF THE FEDERAL GOVERNMENT AS ITS AUTHORIZED LEGAL REPRESENTATIVE, YOU REPRESENT AND WARRANT THAT YOU HAVE FULL AUTHORITY TG BIND
LICENSEE TO THESE TERMS. IF YQU DO NOT AGREE TO THE TERMS OF THIS LICENSE, PLEASE RETURN YOUR MATROX PRODUCT. IF THE SOFTWARE WAS DOWNLOADED,
DESTROY ALL COPIES OF THE SOFTWARE.
In this License “Software” refers to: any fimware, software, associated softwars components, media, printed materials, and “online” or electronic documentation related to Matrox products.
The Software is not sold, and instead is only licensed for use, strictly in accordance with this document. This License does nat cover the sale of hardware, since it may not necessarily be sold as
& package vith the Software. This License sefs forth the terms and conditions of the Software license orly.
Any Software provided to Lienses is the copyrighted work of Matrax andior third party software suppliers (if any). The present License does not give Licensee any intellectual property rights to
the Software o its derivatives. The downloading and/or the use of any Software are subject to the following restiictions and limitations:
LICENSES:
If you are an end user, the "End User License" shall apply to you.
If you are an original equipment manufacturer (OEM), the "OEM License” shall apply to you.

v
END USER LICENSE

Copyright © 2015 Matrox Electronic Systems Ltd. Al rights reserved.

Firmware version
Displays the current firmware version of your Monarch HD device. To update the
Monarch HD firmware, see “Updating the Monarch HD firmware” on page 20.

Documentation
You can access PDF versions of the latest Monarch HD documentation by
clicking the link on the About page. An Internet connection is required.
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Recording file size and duration
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of approximated recording file
sizes and recording lengths.
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Recording file sizes and duration

The following tables list the approximate recording file size based on the average
video data rate and recording duration, and the approximate maximum recording
duration given the average video data rate and available disk space.

Note Unless a specific recording duration limit was set in the record settings,
your Monarch device limits the duration of each recording to 4 hours and 50
minutes. The recording will automatically stop when the duration limit is

reached.
Approximate file size
Recording Average Video Data Rate (kb/s)
Duration 500 2000 5000 15 000 25000

5 min 18.8 MB 75 MB 188 MB 563 MB 938 MB
30 min 1125 MB | 450 MB 1.1 GB 3.4GB 5.6 GB
60 min 225 MB 900 MB 23GB 6.8 GB 11.3GB

3 hrs 675 MB 2.7GB 6.8 GB 20.3 GB 33.8GB
4hrs 50min | 1.1 GB 4.5 GB 11.3 GB 33.8GB 56.3 GB

Approximate maximum recording duration

Average Video Data Rate (kb/s)

Disk Space
500 2000 5000 15 000 25000

4 GB 17.8 hrs 4.4 hrs 107 min 36 min 21 min

16 GB 71.1 hrs 17.8 hrs 7.1 hrs 2.4 hrs 85 min

32 GB 142.2 hrs 35.6 hrs 14.2 hrs 4.7 hrs 2.8 hrs

64 GB 284.4 hrs 71.1 hrs 28.4 hrs 9.5 hrs 5.7 hrs

256 GB 1138 hrs 284.4 hrs 114 hrs 38 hrs 22.8 hrs

1 TB 4444 4 hrs | 1111.1 hrs | 4444 hrs | 148.1 hrs 89 hrs

Appendix A, Recording file size and duration
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instructions for sharing
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Monarch.
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Introduction

®

This appendix describes how to set up shared folders on a Windows or Mac
system so they can be used as destination folders for Monarch recordings.

Important Please note the following about creating shared folders:
* When specifying the path, all folders in the path must already exist. Monarch
will not create new folders.

* When creating a shared folder for Monarch recordings (see “Destination
settings (for recording)” on page 46), you must also specify the basename of
the file since you are creating the file at that point.

Recording to folders on a USB or SD card

When recording to a USB device or SD card, enter the folder(s) on the recording
device to which you want to record, if applicable, followed by the basename.

For example, if you want to name your file “Recordingl”, and save the file in a

folder named “Files” that is contained within another folder named “Project” on
the root directory, enter Project/Files/Recordingl. If you want to save the file in
the media device's root directory, enter Recordingl.

Recording to folders on a network drive

®

This option allows you to record to a shared folder on the network. The method
for entering the location depends on the operating system of the computer that
contains the shared folder. For more information on supported operating systems,
see “Supported operating systems” on page 2.

On a Windows system

When recording to a shared folder that is on a Windows system on the network,
you must enter the IP address of the location on the network that will receive the
file, followed by the shared folder name, and then the basename .

Use the following format:
//IP address/shared folder name/basename

For example, if you want to name your file “Recording1”, and send the file to a
shared folder named “Files” that is located on a network computer with an IP
address of “123.456.7.890”, enter //123.456.7.890/Files/Recording1.

Important If the network destination has a firewall, it must be disabled in
order to send the file to the network location.

Appendix B, Sharing a network folder
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On a Mac OS system

When recording to a shared folder that is on a Mac OS system on the network,
the folder to which you want to send the file must be shared using the Network
File System (NFS) file-sharing protocol.

To share a folder using the NFS protocol, the full path to the folder that you want
to share is required. You can obtain the full path to the folder by right-clicking the
folder, and then clicking Get Info.

Important Shared folders that use a file-sharing protocol other than NFS are
not supported.

1 On the computer that contains the folder that you want to share, make sure
that you're logged in as an administrator and that your user account has a
password. User accounts that do not have a password cannot be used to share
a file using the NFS protocol.

2 In the Finder menu, choose File > New Finder Window.

3 In the Applications folder, click the Utilities folder, and then click
Terminal.

4 In the Terminal window, type the following command, where “Path” is the
full path to the folder that you want to share:

echo /Path -mapall=$(logname)| sudo tee -a /etc/exports

For example, to share a folder named Files that is located on the Desktop
under Matrox in the Users root directory folder, type the following
command:

echo /Users/Matrox/Desktop/Files -mapall=$(logname)| sudo tee -a
/etc/exports

For added security, you can restrict write access to the folder to one device
by adding the IP address of the Monarch device that you want to use to write
to the folder. For example, if the IP address of the Monarch device is
169.254.1.11, type the following command:

echo /Users/Matrox/Desktop/Files 169.254.1.11 -mapall=$(logname)| sudo
tee -a /etc/exports

5 Press ENTER.
6 Type your user account password, and then press ENTER.
7 Type the following command:
sudo nffsd restart
8 Press ENTER.
9 Close the Terminal window.

The folder is now a shared folder.

Recording to folders on a network drive
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10 Now that you have created the shared folder, you must specify the folder

L

path in the Monarch Command Center.

When entering the folder, you must enter the IP address of the location on
the network to which you want to record, followed by the full path to the
shared folder from the root directory, and then the basename.

Use the following format:
//IP address:/full path to shared folder/basename

For example, if you want to name your file “Recording1” and save the file to
a shared folder named “Files” that is located on the Desktop under “Matrox”
in the Users root directory folder on a network computer with an IP address
of “123.456.7.890”, enter the following:

//123.456.7.890:/Users/Matrox/Desktop/Files/Recording 1

Tip You can obtain the full path to the shared folder by right-clicking the
folder, and then clicking Get Info.

The Monarch can now record to the shared folder.

Appendix B, Sharing a network folder
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General

* Regulatory compliance
— FCC Class B, CE Mark Class B, ACMA C-Tick Mark, VCCI
— RoHS Directive 2002/95/EC

¢ Power

Line voltage: 100-240 VAC, 0.5 A

Frequency: 50-60 Hz

Input: External AC/DC adapter (IEC320-C8)

Output: +5VDC, 3A max

Total power consumption: 15 watts

DIN4 locking power connector

Connections
¢ HDMI input

— Supported video input formats (auto-detected):
« 1920x1080p at 23.98/24/50/59.94/60 fps
« 1280x720p at 50/59.94/60 fps
« 1920x1080i at 23.98/24/25/29.97 fps
HDMI Y,Cb,Cr 4:2:2 / RGB
First two channels of embedded audio
Standard Type A HDMI connector (19 pins)
 HDMI output

« Passthrough of video input signal

- HDMI Y,Cb,Cr 4:2:2 / RGB

« Passthrough of two channels of embedded audio

+ Standard Type A HDMI connector (19 pins)
* Unbalanced analog audio input

— Ix stereo 3.5 mm (1/8") stereo jack
— Input impedance: Hi-Z
— Nominal live level -10 dBv with 4 dB headroom
¢ Unbalanced analog audio output
— Ix stereo 3.5 mm (1/8") stereo jack
— Output impedance: 25 Q
— Nominal live level -10 dBv with 4 dB headroom
* Analog In to Analog Out audio performances at Line Level (-10dBv)

Appendix C, Matrox Monarch HD Specifications
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— THD+N at 1kHz: < .042%
— Frequency response: 20 Hz to 20 Khz +/- 1 dB
— Signal-to-noise ratio: Typical 80 dB
* Data ports
— 2x 2.0 USB ports
— 1 x auto-sensing 10/100/1000 Base-T Ethernet J-45 port
— 1 x SD/SDHC card slot.

Environmental specifications
* Minimum/maximum room operating temperature: 0 to 40° C

* Minimum/maximum storage temperature: —20 to 60° C

* Maximum altitude for operation: 3,000 meters

* Maximum altitude for transport: 12,000 meters

* Operating humidity: 20 to 80% relative humidity (non-condensing)

* Storage humidity: 5 to 95% relative humidity (non-condensing)

Dimensions

The dimensions for the Monarch HD are as follows.

Dimensions
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Your notes
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How to get Matrox customer support

If you have a problem that you’re unable to solve by referring to the
documentation for your Matrox product, please contact your Matrox
representative. He or she should be able to help you quickly correct any
installation or system configuration problem.

If your representative is unable to solve your problem, contact Matrox for further
information and assistance.

Registration
You can register your Matrox product in the Matrox Support section of our
website at www.matrox.com/video/support.

Only registered users are entitled to customer support, utilities, special
promotional offers, and access to our user forum.

Keep up to date with our website

In addition to registering your Matrox product, our website offers you
up-to-the-minute information about Matrox products and software updates. Be
sure to place our site in your favorites or bookmarks:
www.matrox.com/video/support.

Contacting us

Matrox is proud to offer worldwide customer support. Please use the contact
information for your Matrox product and area as provided on our website at
www.matrox.com/video/support.

Appendix D, Matrox Customer Support
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Compliance Statements
USA

FCC Compliance Statement

Remark for the Matrox hardware products supported by this guide

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate
radio frequency energy and, if not installed and used in accordance with the instructions manual, may cause harmful interference to radio communications. Operation of
this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

WARNING
Changes or modifications to this unit not expressly approved by the party responsible for the compliance could void the user’s authority to operate this equipment. The
use of shielded cables for connection of the equipment and other peripherals is required to meet FCC requirements.

Canada

(English) Industry Canada Compliance Statement

CAN ICES-3 (A)/NMB-3 (A)

Remark for the Matrox hardware products supported by this guide

These digital devices do not exceed the Class A limits for radio noise emission from digital devices set out in the Radio Interference Regulation of Industry Canada.

(Francais) Conformité avec les exigences de I'Industrie Canada

CAN ICES-3 (A)/NMB-3 (A)

Remarque sur les produits matériels Matrox couverts par ce guide

Ces appareils numériques n’émettent aucun bruit radioélectrique dépassant les limites applicables aux appareils numériques de Classe A prescrites dans le Reglement sur
le brouillage radioélectrique édicté par Industrie Canada.

Europe

(English) European user’s information — Declaration of Conformity

Remark for the Matrox hardware products supported by this guide

These devices comply with EC Directive 2014/30/EU for a Class A digital device. They have been tested and found to comply with EN55022/CISPR22 and
EN55024/CISPR24. In a domestic environment these products may cause radio interference in which case the user may be required to take adequate measures. To meet
EC requirements, shielded cables must be used to connect the equipment and other peripherals. These products have been tested in a typical Class A compliant host
system. It is assumed that these products will also achieve compliance in any Class A compliant system.

(Frangais) Informations aux utilisateurs Européens — Déclaration de conformité

Remarque sur les produits matériels Matrox couverts par ce guide

Ces unités sont conformes 2 la directive communautaire 2014/30/EU pour les unités numériques de classe A. Les tests effectués ont prouvé qu’elles sont conformes aux
normes EN55022/CISPR22 et EN55024/CISPR24. Le fonctionnement de ces produits dans un environnement résidentiel peut causer des interférences radio, dans ce cas
I’utilisateur peut étre amené a prendre les mesures appropriées. Pour respecter les impératifs communautaires, les cables de connexion entre I’équipement et ses
périphériques doivent étre blindés. Ces produits ont été testés dans un systeme hote typique compatible classe A. On suppose qu’ils présenteront la méme compatibilité
dans tout systeme compatible classe A.

(Deutsch) Information fiir europdische Anwender — Konformitatserklarung

Anmerkung fiir die Matrox Hardware-Produktunterstiitzung durch dieses Handbuch

Diese Gerite entsprechen EG Direktive 2014/30/EU fiir ein digitales Gerit Klasse A. Sie wurden getestet und entsprechen demnach EN55022/CISPR22 und
EN55024/CISPR24. In einer Wohnumgebung konnen diese Produkte Funkinterferenzen erzeugen, und der Benutzer kann genétigt sein, entsprechende Manahmen zu
ergreifen. Um EG-Anforderungen zu entsprechen, miissen zum AnschlieBen des ausriistung und anderer Peripheriegeriite abgeschirmte Kabel verwendet werden. Diese
Produkt wurden in einem typischen, der Klasse A entsprechenden, Host-System getestet. Es wird davon ausgegangen, daf diese Produkte auch in jedem Klasse A
entsprechenden System entsprechend funktionieren.

(Italiano) Informazioni per gli utenti europei — Dichiarazione di conformita

Nota per i prodotti hardware Matrox supportati da questa guida

Questi dispositivi sono conformi alla direttiva CEE 2014/30/EU relativamente ai dispositivi digitali di Classe A. Sono stati provati e sono risultati conformi alle norme
EN55022/CISPR22 e EN55024/CISPR24. In un ambiente domestico, questi prodotti possono causare radiointerferenze, nel qual caso all’utente potrebbe venire richiesto
di prendere le misure adeguate. Per soddisfare i requisiti CEE, 1’apparecchiatura e le altre periferiche vanno collegati con cavi schermati. Questi prodotti sono stati provati
in un tipico sistema host conforme alla Classe A. Inoltre, si da per scontato che questi prodotti acquisiranno la conformita in qualsiasi sistema conforme alla Classe A.

(Espaiiol) Informacion para usuarios europeos — Declaracién de conformidad

Observacion referente a los productos de hardware de Matrox apoyados por este manual

Estos dispositivos cumplen con la directiva de la CE 2014/30/EU para dispositivos digitales de Clase A. Dichos dispositivos han sido sometidos a prueba y se ha
comprobado que cumplen con las normas EN55022/CISPR22 y EN55024/CISPR24. En entornos residenciales, estos productos pueden causar interferencias en las
comunicaciones por radio; en tal caso el usuario deberd adoptar las medidas adecuadas. Para satisfacer las disposiciones de la CE, deberan utilizarse cables apantallados
para conectar el equipo y demds periféricos. Estos productos han sido sometidos a prueba en un tipico sistema anfitrion que responde a los requisitos de la Clase A. Se
supone que estos productos cumplirdn también con las normas en cualquier sistema que responda a los requisitos de la Clase A.
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